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I MPORTANTE : leggere primad’iniziare
I

Grazie per avere acquistato un prodotto Sigma

Per ottenere il massimo, e non causare danni o malfunzionamenti, leggere attentamente
guesto manuale, prima di usare il prodotto.

Nota bene

o Non riprodurre questo manuale tutto o in parte, senza permesso scritto.

o | contenuti di questo manuale possono essere cambiati senza preavviso.

e Abbiamo messo la massima attenzione nella stesura di questo manuale, tuttavia, se riscontrate
errori, contattate il nostro rappresentante locale. Tuttavia decliniamo ogni responsabilita per
eventuali errori..

o Le caratteristiche del prodotto possono essere cambiate senza preavviso..

e SIGMA e i suoi rappresentanti declinano ogni responsabilita circa eventuali inconvenienti
causati dall’uso di questo programma

Per evitare danni o malfunzionamenti leggere attentamente quanto segue, prima di usare il
programma.

A Attenzione ! Ignorare questo segnale pud portare a seri inconvenienti e danni

AAttenzione

Non inserite il/i CD-ROM acclusi in un lettore Audio. Ascoltare questo CF-ROM con le cuffie
puo causare danni all’udito. Inserire I’accluso CD-ROM in un lettore per CD musicali puo
danneggiarne gli altoparlanti

Le immagini realizzate con la vostra fotocamera sono per uso personale e il loro uso non deve
contravvenire le leggi del vostro Paese o leleggi internazionali. Inoltre, anche se le immagini sono
di uso personale ricordate che possono esistere divieti di ripresa in occasione di manifestazioni,
spettacoli, fiere ecc. Le leggi riguardanti il diritto d’autore o il diritto all’immagine non possono
essere infrante.

Marchi depositati

= FOVEON é marchio registrato da Foveon, Inc. X3, e X3 & marchio depositato di Foveon Inc..

= Compact Flash & marchio registrato di SanDisk Corporation.

= IBM PC/AT & marchio registrato di International Machines Corporation (IBM) negli Sati Uniti
d'America

= Microsoft and Windows sono marchi registrati 0 marchi proprietari di Microsoft Corporation
negli Stati Uniti e negli altri Paesi

= Macintosh and FireWire sono marchi registrati di Apple Computer Inc. negli Stati Uniti e negli
altri Paesi

= Adobe and Adobe Photoshop, sono marchi registrati di Adobe System Incorporated.

= Microdrive & un marchio registrato di Hitachi Global Storage Technologies.

= Tutte le ditte e i marchi nominati in questo manuale, sono registrati e di proprieta delle rispettive
Ditte aventi diritto.
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1 I TRODUZIONE
I

In questo capitolo si
spiega...

e Le principali
prestazioni di
SIGMA Photo Pro

e Come consultare
guesto manuale




1 INTRODUZIONE

1.1 SIGMA Photo Pro

Cosa potete fare con SIGMA Photo Pro. Informazioni veloci

Sotto potete vedere finestre e "palette” di SIGMA Photo Pro. Cliccare nella finestra o nella
"palette" per visualizzare informazioni piu particolareggiate.

LT =) Finestra principale

Cle DR Gomars Y ook b

o Scarica immagini dalla fotocamera al
computer

o Salvare gruppi di immagini in TIFF 0 JPEG

« Spostare e copiare immagini tra cartelle e
computer

« Contrassegnare, bloccare, ruotare e
cancellare immagini dalla fotocamera o dal

comouter.

Cogmd Caimes 4 Imisgs e [T TRy | F e T IR S Flimdarir Nasipes

Cammera IMGOSESIC OBCD02 1100 AN RS 1S 26 mm 1S0 200 W LT M0
P —

B 512u8 oF Cara

Finestra di
visualizzazione

A ER R R R T o Vedere le immagini
D002 6:06:28 AM FILD 1603 50 men 150 100 H & ingrandite
. e Scegliere una

regolazione

e Salvare le immagini

- e Ingrandire | dettagli

it - MGOSTS o Visualizzare le
maschere di
contrasto

e Contrassegnare,
bloccare, ruotare e
cancellare le
immagini

e Passare da una
immagine all’altra

Arlpsirman Bodn della finestra
principale
gy o Attivare i Controlli
i ' delle Correzioni
S Satting Malidn Seelieg ( Adjustment
Tonal Adjustments S controls)

Finestra d’'Informazioni
sull'immagine

¢ Info sull’acquisizione
e Info sul file
¢ Info sul procedere del lavoro

Color Adjesimeni

Palette delle Correzioni

 Correggere I'immagine, correggere Hliseogram

I'esposizione,il contrasto,le ombre,le luci e la,
saturazione

Regolare il colore

Caricare, salvare e cancellare | parametri
Vista dell'istogramma

Impostare le maschere di contrasto

Manuale SIGMA Photo 2



1 INTRODUZIONE

Elementi della Finestra Principale

Sotto trovate visualizzate le chiavi di accesso della Finestra Principale. Cliccate in ciascun link per
visualizzare la sezione che é dettagliatamente descritta nel manuale.

Cliccare sul pulsante Copy Camera Images p.

14 per scaricare le immagini X3F contenute Cliccare sul pulsante Review
nella fotocamera nella memoria del computer. Images pag. 22 per aprire la
finestra di visualizzazione (Review
Il Pannello della fotocamera p. 11 indica i Window) e lavorare le immagini

collegmamenti con la fotocamera. Cliccando nel
pannello si visualizzano le foto nella finestra dei

provini
. Usare Edit Buttons p20 per
Cliccare sul pulsante Save ruotare, contrassegnare,
Images As p. 28 per lavorare & - pnccare o cancellare le
salvare immagini XF3 nei formati immagini selezionate

TIFF 0 JPEG

Cliccare su Info Button p. 41 per
aprire la Finestra d’Informazioni
sulle Immagini

ER siMa Photo Bro

i | €N R &G
Camera IMGOOS69.X3F 7192002 1:39:16 PM F11 1/60 150 100 HI 6.14 MB
n =03 connected

E¥ 61.3MB CF Card
22 Images (134 MB)

Computer
= A
| 1
* =D
b [0 My Documents
- My Photos
|7 Faworites

{27 Friends

(27 Wacation

1 Image Selected 6.14 MB ...

oo @@ =
888 | mE D 8=

Usare Thumbnail Buttons p. 18 per
determinare stile e grandezza delle

miniature
Il Computer Pane p. 17 visualizza i drive e le cartelle Il Thumbnail Pane p. 18 visualizza
del computer. Cliccare su un drive o una cartella nel le immagini della fotocamera o
Computer Pane per visualizzare immagini o cartelle della cartella che avete scelto

Manuale SIGMA Photo 3



1 INTRODUZIONE

Elementi della Finestra di Visualizzazione

Sotto trovate visualizzate le chiavi di accesso della Finestra di Visualizzazione. Cliccate in ciascun link per

visualizzare la sezione che é dettagliatamente descritta nel manuale.

Premere Navigation Buttons p. 23 per andare avanti
e indietro sulle immagini

Premere il pulsante Save Image As p. 29
per lavorare e salvare immagini X3F in

formato TIFF or JPEG Premere il pulsante X3F

Cliccare Inf(_) Button corrente
p. 41 per aprire la Finestra delle
Informazioni sullImmagine

B Review - IMG09612X3F

o e oy |

Save Image As... o 100% ]

Auto C
Ceorz b G EN R h prrETTE—

IMGO9612.X3F 8/8/2002 6:06:28 AM F8.0 1/60s 50 mm IS0 100 HI 8.35 MB

per aggiornare il file X3F al settaggio

La Loupe p. 23 Adjustment Modes p. 25 consente di
permette di ingrandire visualizzare le immagini con differenti
limmagine correzioni
Usare Edit Buttons
p.20 per ruotare, Premere Adjustment Controls p.
contrassegnare, 32 per aprire Adjustment
cancellare Controls Palette ( Finestra delle
limmagini correzioni)
visualizzata

Adjustment Controls

Manuale SIGMA Photo



1 INTRODUZIONE

1.2 Informazioni su questo manuale

Il manuale fornisce le informazioni necessarie alla installazione e all'uso di SIGMA Photo Pro, il software
dedicato alla fotocamera digitale SD9

Simboli ed espressioni convenzionali

e | percorsi del menu sono indicati nel modo seguente

Menu principale > Scelta della voce di menu

o | tasti funzione sono indicati nel modo seguente

Ctrl/Cmd + lettera o simbolo

“Ctrl” & abbreviazione che sta per Control Key nella piattaforma Windows, mentre la sigla “Cmd”
indica lo stesso comando nella piattaforma Mac.

Navigazione nelle pagine digitali del manuale

Per leggere le pagine del manuale SIGMA Photo Pro mentre lavorate con SIGMA Photo Pro, selezionare
Help=>SIGMA Photo Pro Help
da qualsiasi finestra del menu, oppure digitare Ctrl/Cmd + ? sulla tastiera

Le seguenti opzioni, presenti nella versione PDF del manuale vi aiuteranno nella navigazione e nella
ricerca veloce

Usare Bookmarks per
trovare gli argomenti
principali

Bl @ & Bookmark =

L]File type e
D Resalution
(] Adjustment Settings

| adobe Reader

T Ble  Edit Mew Document Tools Window  Help

Topen B o= 99 T TTiselestted - (@ £ .

!

Usare il tasto di
Ricerca per trovare gli
accessi
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2 SETTARE IL COMPUTER
I

In questo capitolo
imparerete a...

e [nstallare SIGMA
Photo Pro nel
computer

e Settare il monitor

Manuale SIGMA Photo Pro 6



2 SETTAGGIO DEL COMPUTER

2.1 Installare il programma

Caratteristiche indispensabili di Windows

Se usate la vostra fotocamera digitale con un PC, queste sono le caratteristiche minime necessarie per poter
utilizzare il programma SIGMA Photo Pro

Pentium Il 233MHz o superiore

Windows 98 SE, Windows 2000, Windows ME, Windows XP

256 MB RAM

40 MB di hard disk

Display card a 16 o, meglio, a 24-bit

Monitor con risoluzione 800x600 pixel 0 maggiore. Raccomandato un monitor da 1024x768
Porta USB o IEEE 1394 (Fire Wire)

Lettore CD-ROM

Caratteristiche indispensabili per Mac

Se usate la vostra fotocamera digitale con un Mac queste sono le caratteristiche minime necessarie per
poter utilizzare il programma SIGMA Photo Pro:

Processore Power PC

Sistema Mac OS 9, Mac OS X

RAM 256 MB

40 MB di hard disk

Monitor con risoluzione 800x600 pixel 0 maggiore. Raccomandato un monitor da 1024x768
Porta USB o IEEE 1394 (FireWire)

Lettore CD-ROM

Installare e disinstallare il programma

Per installare SIGMA Photo Pro nel computer, inserite il CD del programma fornito assieme alla
fotocamera SD9. Cliccate due volte sull'icona del CD che compare nella scrivania. Poi cliccare due volte su

+  Set Up, se usate la piattaforma Windows, oppure due volte
su Installer se usate la piattaforma Mac.

Una finestra di benvenuto comparira nello schermo del
computer.

Una procedura d'aiuto vi condurra, passo passo, a scegliere
il linguaggio SIGMA Photo Pro, a creare le cartelle per le
applicazioni e via di seguito.

E' necessario chiudere altri eventuali programmi, prima di
installare SIGMA Photo Pro, e poi riavviare il computer.

Per disinstallare il programma, con piattaforma Windows, scegliere I'opzione Uninstall (Disinstalla) dal
Menu di Avvio del programma Sigma Photo Pro, oppure Add/Remove Program tra le opzioni del Pannello
di Controllo

Per disinstallare il programma, con piattaforma Macintosh, cliccare due volte sull'icona Uninstaller nella
cartella delle applicazioni SIGMA Photo Pro.

Manuale SIGMA Photo Pro 7



2 SETTAGGIO DEL COMPUTER

Installare i driver della fotocamera

Per comunicare con il programma SIGMA Photo Pro la SD9 ha bisogno di un driver. Con la piattaforma
Mac il driver viene automaticamente installato. Con la piattaforma Windows &, invece, necessario
installarlo mediante Hardware Wizard.

1) Assicuratevi che I'alimentazione della fotocamera sia spenta
2) Inserire il cavetto IEEE 1394 (Fire Wire) nel computer e nella fotocamera
3) Accendere la fotocamera e attendere che appaia Hardware Wizard

4) Seguire le istruzioni di Hardware Wizard. Se vi si richiede di specificare I'allocazione,
raggiungete I'allocazione dell'installazione SIGMA Photo Pro. Nell” installazione piu comune il
percorso ¢ il seguente

C:\Program Files\SIGMA\Photo Pro\Drivers
durante l'installazione vi verra richiesto di specificare altre volte questa allocazione

5) Una volta specificata I'allocazione seguite le istruzioni rimanenti, fino al click su Finish.

E' richiesta la medesima procedura per ogni porta USB e IEEE 1394 (FireWire™)

Non collegare mai la fotocamera al computer tramite tutte e due le porte, USB e IEEE 1394 (FireWire™),
contemporaneamente.

Manuale SIGMA Photo Pro 8



2 SETTAGGIO DEL COMPUTER

2.3 Settaggio del monitor

Verifica della luminosita, del gamma e dei colori del monitor

Sarete avvantaggiati se lavorerete le immagini con un monitor che offre colori reali. Col passare del tempo
le caratteristiche del monitor cambiano, percio & necessario regolare i colori periodicamente. Consultare il

manuale d'istruzioni del monitor ed eseguire la regolazione dei colori secondo la procedura raccomandata

dal costruttore..

Potete verificare il segnale d'uscita del monitor attraverso SIGMA Photo Pro scegliendo la voce
Tools>Verifying Monitor nella finestra principale.

| grafici del box servono per controllare solamente gamma e luminositd. Usare i controlli indicati nel
manuale d'uso del monitor per eseguire le varie regolazioni.

Uso di un profilo monitor
= —— giaimpostato
|
SIGMA Photo Pro accetta i
fy that your monitor display profili monitor.
Per maggiori informazioni sui
profili medesimi consultare il
libretto d'istruzioni del monitor
oppure del sistema operativo.

column dowan the center,

Scegliere larisoluzione piu
adatta alle dimensioni
dello schermo

SIGMA Photo Pro é progettato
per lavorare con un monitor che
abbia una risoluzione di
800x600, tuttavia l'area nella
quale si vedono le immagini e le
miniature non ¢ ottimizzata per
uno schermo di cosi piccole
dimensioni. Una risoluzione di
1024x768 o anche maggiore
Pattern 2: offre maggiori opportunita di
lavorare con le immagini.
Sigma Photo Pro ottimizza
automaticamente l'area di
visione quando, all'inizio della
sessione di lavoro, si lancia il
programma. A questo punto &
possibile ridimensionare la
finestra principale o quella di
visualizzazione, o
ridimensionare il pannello dei
provini all'interno della finestra
principale, oppure muovere le
finestre in qualsiasi parte dello
schermo.
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3 PRIMA DI INIZIARE
I

In questo capitolo
si insegna come...

e collegare la
fotocamera al
computer

e |anciare SIGMA
Photo Pro
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3 PRIMA DI COMINCIARE

3.1 Collegare la fotocamera al computer

Con SIGMA Photo Pro é possibile collegare al computer una sola fotocamera SD9 alla volta.
Solamente scollegando eventuali altre fotocamere é possibile ottenere un corretto funzionamento del
programma.

Collegare i cavetti

Assicurarsi che l'alimentazione della fotocamera sia spenta, prima di collegare il cavetto USB o IEEE
1394 (FireWire™). Collegare la fotocamera al computer. Non collegare mai la fotocamera al computer
contemporaneamente mediante entrambe le porte: USB e IEEE 1394 (FireWire™)

Accendere |la fotocamera

Accendere la fotocamera seguendo le istruzioni del manuale. SIGMA Photo Pro non rileva la presenza
della fotocamera se non é stata accesa, dopo averla collegata al computer..

A questo punto siete pronti all'installazione del driver, install a driver ( p.8) se & la prima volta che
collegate la fotocamera SD9 al computer

. Una volta accesa e collegata la fotocamera il programma SIGMA Photo Pro viene automaticamente
lanciato. Nello schermo comparira la Finestra Principale (Main Window) con Pannello delle Miniature

(Thumbnail Pane) evidenziati in blu. le immagini contenute nelle CF Card compariranno nello schermo.

I Pannello delle Miniature privo di immagini indica che nessuna fotografia & presente nelle memorie
della fotocamera.

La barra di colore blu
indica che le immagini
contenute nella card
sono visualizzate nel
Pannello delle Miniature

ﬂ Cameta connected

L'icona della
batteria indica la
fonte di corrente

Bl s12MB CF Caro

| simboli della
fotocamera e della
card indicano
l'avvenuta
connessione

Passare dalla alimentazione a batteria alla alimentazione a rete(AC)

Quando si collega la fotocamera al computer & consigliabile usare I'alimentazione a rete. In questo
modo si risparmiano le batterie e si evitano malfunzionamenti dovuti al calo di tensione delle batterie

Camera Quando si passa all'alimentazione a rete, al posto del
n Camera connected o simbolo della batteria compare quello della rete.

E 17 ME CF Card Quando si usa la corrente delle batterie, il simbolo della
batteria lampeggia di rosso periodicamente, per
22 Images (138 MB) ricordare che si consuma corrente. Cio non significa che

il livello delle batterie sia basso.

Collegare la fotocamera mentre il programma e in funzione

Se il programma SIGMA Photo Pro ¢ in funzione e collegate la fotocamera al computer, le immagini
contenute nella fotocamera non vengono automaticamente visualizzate nella finestra principale. Se si
desidera vedere le immagini & necessario cliccare nel Pannello della Fotocamera (Camera Pane)

Manuale SIGMA Photo Pro
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3 PRIMA DI COMINCIARE

3.2 Lanciare il programma

Aprire e chiudere SIGMA Photo Pro

All'avvio del computer SIGMA Photo Pro viene automaticamente lanciato e la Finestra Principale
(Main Window) compare nello schermo con il pannello della fotocamera che rimane evidenziato finché
non si spegna la fotocamera stessa. Se non compaiono immagini nel Pannello delle Miniature
(Thumbnail Pane) significa che la fotocamera non contiene immagini

E' possibile lanciare il programma SIGMA Photo Pro, senza che la fotocamera
sia collegata, cliccando due volte sulla icona delle applicazioni. Comparira la
Finestra Principale e nel Pannello del Computer (Computer Pane) risultera
selezionata l'ultima cartella che avevate aperto. Tutte le immagini contenute in
questa cartella, XF3, JPEG oppure TIFF saranno visualizzate. Nessuna cartella
risultera selezionata se ¢ la prima volta che aprite il programma SIGMA Photo
Pro

Per uscire dall'applicazione, cliccare nel riquadro presente nella barra dei titoli della Finestra Principale
(Main Window), oppure impostare File > Exit nel menu della finestra principale..

Attivare/disattivare il lancio automatico del programma

L'impostazione di default prevede il lancio automatico di SIGMA Photo Pro quando viene collegata la
fotocamera SD9. Se non volete che SIGMA Photo Pro parta ogni volta che collegate la fotocamera al
computer e l'accendete, potete disattivare la funzione impostando Camera > Auto-Launch Setting dal
menu della finestra principale.

Auto Launch Sekting A

Fi  Enable Auto Launch

8] 4
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4 TRASFERI

R E

MMAG

N

In questo capitolo
s’'imparaa...

e trasferire le
immagini dalla
fotocamera al
computer

e cancellare le
immagini dalla
CF card dalla
quale le avete
trasferite
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4 TRASFERIMENTO IMMAGINI

4.1 Trasferire le immagini dalla fotocamera al computer

Usare il pulsante Copy Camera Images
i =

Fla ER Conea Bew [soh Mel

Il trasferimento delle immagini dalla fotocamera in una cartella nella memoria del computer assicura la
memorizzazione, per qualsiasi uso successivo, dei file X3F. Durante I'operazione vengono anche
contrassegnate le immagini trasferite dalla CF card, per garantire loro una sicura identificazione. Cio ¢ utile
guando si rivedono vecchie immagini contenute nella fotocamera. E' anche possibile cancellare immagini
dalla CF card, per fare spazio ad altre immagini.

Per trasferire i file X3F dalla fotocamera al computer:

1) Collegare e accendere la fotocamera.

2) Selezionare Camera nella finestra principale del pannello di navigazione

3) Quando si desidera trasferire solamente determinate immagini, selezionatele o contrassegnatele
(Le immagini contrassegnate nella fotocamera rimangono segnate anche per SIGMA Photo Pro

4) Cliccate il pulsante Copy Camera Images.

Comparira la seguente finestra di dialogo:

Source Sorgente
Scegliere le immagini da trasferire cliccando nel
circoletto per tutte (all), solamente quelle
contrassegnate (marked) oppure scelte (selected)

Modalita di trasferimento

Cliccare nel riquadro di controllo per cancellare le
immagini dalla CF card, terminato il loro
trasferimento dalla fotocamera al computer

Transfer Option

W Delete X3F T

Destination Folder Destinazione:
Cliccare sul pulsante Chose per scegliere in quale
settore del computer archiviare le immagini X3F

Choose...

Cancel Cliccare OK per iniziare il trasferimento,
oppure Cancel per tornare alla finestra
principale

Usare il lettore di CF card per trasferire le immagini nel computer

Se il computer ha un drive per il lettore di CF card, SIGMA Pro Photo ¢ in grado di evidenziarlo nel
pannello di navigazione (Navigation Pane). E' possibile usare il lettore per trasferire le immagini dalla CF
Card al computer, perd i file X3F non potranno essere contrassegnati mentre vengono trasferiti.
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5 LAVORARE LE IMMAGINI
I

In questo capitolo
s’'imparaa...

visualizzare, osservare,
ordinare le immagini

e scegliere e spostare le
immagini

e rinominare le immagini

e segnare, bloccare,
ruotare le immagini

e cancellare le immagini

Manuale SIGMA Photo Pro
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5.1 Panoramica sulla Finestra Principale

Funzioni principali
Dalla Finestra Principale si possono eseguire le seguenti operazioni:

Trasferire immagini dalla fotocamera al computer

Visualizzare immagini in forma di miniature

Lavorare e salvare immagini a gruppi

Copiare e inserire immagini in nuove cartelle

Ruotare, segnare o bloccare immagini

Rinominare o cancellare immagini

Entrare nella finestra delle informazioni sulle immagini

Aprire una immagine nella finestra di visualizzazione (Rewiev Window)

Il pannello delle Miniature (Thumbnail Pane) visualizza immagini prendendole direttamente dalla
fotocamera quando é impostato Camera Pane (Pannello della Fotocamera), o da qualsiasi cartella
selezionata, quando Computer Pane. Computer Pane € attivo quando ¢ evidenziato in blu.

La finestra principale & sempre aperta quando si lavora con SIGMA Photo Pro. Chiudendo questa finestra si
esce dal programma e si chiudono anche tutte le altre finestre e "palette”, eventualmente aperte

Link per informazioni piu dettagliate

Cliccare sui link indicati sotto per avere informazioni pit dettagliate sugli elementi contenuti nella Finestra
Principale.

Ruotare, contrassegnare e
bloccare immagini

Lavorare e salvare Aprire la Finestra di
Immagini Visualizzazione
Copiare immagini dalla Info
fotocamera sullimmagine | Cancella

B 51GMaA Photd Pro
File Edit Camea Wiew Tools Help

Pannello Copy Camera Images... Save Images As... £ W o=, Review Images

de”a Camera IMGD569.X3F 91572002 11:31:38 AM F9.5 111255 25 mm IS0 200 HI 7.77 MB
fotocamera ) Camera connected P
EY Mime cF Cord

Computer

Pannello delle
miniature

Pannello del
computer

v [0 My Photos
@ “acation
e

&rF

b 2 Metweork

View: All

Finestra principale

Cambiare I'aspetto delle
miniature
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Cambiare le dimensioni della finestra principale

Usare i pulsanti nella barra del titolo per aumentare, ridurre o ritornare alle dimensioni della Finestra
Principale. Potete trascinare la tavoletta nell'angolo in basso a destra per variare a volonta le dimensioni
della finestra principale.

Cambiare le dimensioni del pannello delle miniature e di quello di navigazione

Per cambiare le dimensioni relative del Pannello di Navigazione (Navigation Pane) e di
Tools Help quello delle Miniature (Thumbnali Pane) cliccare e trascinare la barretta di selezione

; esistente tra i due pannelli. SIGMA Photo Pro riproporra questa dimensione alla prossima
riapertura del programma.

Spostare il margine grigio da destra o sinistra
per cambiare le dimensioni dei Pannelli delle
Miniature e di Navigazione

QG e

a =09 connected

[E¥ 613 MB CF Card
. 9 Images (57MB)

Vedere le immagini memorizzate nella fotocamera

Cliccare nel Pannello della Fotocamera (Camera Pane) per visualizzare le
immagini della fotocamera. La scritta Camera Pane risultera evidenziata e
le immagini presenti nella fotocamera saranno visualizzate nel Pannello

Computer